
 Ciljevi učenja 
•	 Projektujte sklopove od dna ka vrhu
•	 Primenjujte uklapanja na sklopove
•	 Projektujte sklopove od vrha ka dnu
•	 Pomerajte pojedinačne komponente
•	 Rotirajte pojedinačne komponente
•	 Predstavite komponente sklopova na osnovu njihovih fizičkih svojstava

Poglavlje 12

Oblikovanje  
sklopa – I
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OBLIKOVANJE SKLOPA
Projekat sklopa sastoji se od više sastavnih delova postavljenih na odgovarajuće rad-
ne pozicije pomoću parametarskih relacija. U SOLIDWORKSu se to naziva uklapa-
nje ili uparivanje (engl. mate). Uklapanja omogućavaju da komponentama ograni-
čite stepen slobode na njihovim radnim pozicijama. Da biste prešli u režim rada sa 
sklopovima (Assembly), otvorite okvir za dijalog New SOLIDWORKS Document i 
pritisnite dugme Assembly (slika 12-1).

Slika 12-1  Okvir za dijalog New SOLIDWORKS Document

Zatim pritisnite dugme OK. Nov dokument sklopa otvoriće se u režimu Assem-
bly i prikazaće se pano Begin Assembly PropertyManager sa okvirom za dijalog 
Open (slika 12-2). 

Načini projektovanja sklopa
U SOLIDWORKSu postoje dva načina projektovanja sklopova: od dna ka vrhu 
(engl. bottom-up) i od vrha ka dnu (engl. top-down). O njima govorimo u nastavku.

Projektovanje sklopa od dna ka vrhu
Projektovanje od dna ka vrhu tradicionalan je i najčešće korišćen pristup projekto-
vanju sklopova. U njemu se sve komponente prave kao zasebni dokumenti dela, a u 
sklopu se postavljaju i referenciraju kao spoljne komponente. Pri takvom pristupu, 
komponente se prave u režimu rada s delovima (Part) i snimaju se kao datoteke s 
nastavkom.sldprt. Pošto napravite i snimite sve komponente sklopa, otvorićete nov 
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dokument sklopa (.sldasm) i umetnuti komponente pomoću alatki dostupnih u re-
žimu Assembly. Nakon umetanja, sastavićete komponente tako što ćete ih uklopiti.

Slika 12-2  Režim Assembly i pano Begin Assembly PropertyManager

Glavna prednost ovakvog projektovanja sklopova jeste to što u tekućoj datote-
ci postoji samo jedan deo. Zahvaljujući tome, možete obratiti više pažnje na poje-
dinačne složene oblike. Ovo je omiljeni način rada s velikim sklopovima koji sadr-
že složene delove.

Projektovanje sklopova od vrha ka dnu
U pristupu od vrha ka dnu, komponente se prave u istom dokumentu sklopa, i 
motu biti sačuvane zajedno sa sklopom ili u posebne datoteke delova. Zbog toga se 
projektovanje od vrha ka dnu potpuno razlikuje od projektovanja od dna ka vrhu. 
Rad ćete početi u dokumentu sklopa, a geometriju jednog dela definisaćete pre-
ma geometriji drugog.

Napomena
Sklop možete napraviti i kombinovanjem pristupa od dna ka vrhu i od vrha ka dnu.

IZRADA SKLOPOVA OD DNA KA VRHU
Već znate da se komponente sklopova projektovanih od dna ka vrhu prave kao za-
sebni dokumenti dela u režimu Part. Napravljene komponente se umeću u sklop 
i sastavljaju pomoću uklapanja. Kad projektujete sklop na ovaj način, prvo treba 
da umetnete komponente koje čine sklop. Preporučuje se da se prva komponenta 
postavi u koordinatni početak dokumenta sklopa. Tako će se početne ravni sklopa 
i dela podudarati i komponenta će imati istu orijentaciju kao u režimu Part. Kada 
postavite prvu komponentu sklopa, ona će biti fiksirana na svom položaju. U na-
stavku predstavljamo tehnike postavljanja komponenata sklopa.
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Postavljanje komponenata u dokument sklopa
U SOLIDWORKSu postoje razne opcije za postavljanje komponenata u sklop. Sle-
di njihov opis.

Postavljanje komponenata pomoću panoa PropertyManager
  CommandManager:	 Assembly > Insert Components potpaleta > 	  
			   Insert Componenets				     
  Glavni meni:		  Insert > Component > Existing Part/Assembly	  
  Paleta alatki:		  Assembly > Insert Components potpaleta >	  
			   Insert Componenets				  

Kada otvorite nov dokument u režimu As-
sembly, otvoriće se pano Begin Assembly 

PropertyManager (slika 12-3). Taj pano se otvara 
samo kada započinjete nov dokument dela. Postu-
pak rada je opisan na potpanou Message. Kao što 
je ranije rečeno, možete da izaberete deo ili sklop 
i da postavite komponentu u oblasti za crtanje, ili 
da pritisnete dugme Create Layout i napravite 
sklop od vrha ka dnu. Kada pritisnete dugme 
Browse na potpanou Part/Assembly to Insert, 
otvoriće se okvir za dijalog Open. Pronađite folder 
u koji je snimljena komponenta, izaberite je i pri-
tisnite dugme Open. Pojaviće se kursor za rad s 
komponentama i grafički prikaz komponente. 
Ime izabrane komponente biće navedeno u polju 
Open documents, zajedno s paletom Rotate con-
text toolbar, kao što je prikazano na slici 12‑4. Ako 
paleta Rotate context toolbar nije prikazana u 
oblasti za crtanje, otvorite je tako što ćete potvrdi-
ti opciju Show Rotate context toolbar na potpa-
nou Options panoa Begin Assembly PropertyMa-
nager. Komponentu možete rotirati oko ose X, Y 
ili Z pre stavljanja u oblasti za crtanje. Unesite 
vrednost ugla u polje brojača Angle i izaberite op-
ciju Rotate component about X, Rotate compo-
nent about Y ili Rotate component about Z da bi-
ste rotirali komponentu oko X, Y odnosno Z ose. 
Komponentu možete rotirati i za 90 stepeni, tako 
što desnim tasterom miša pritisnete oblast za crta-
nje, pa iz priručnog menija izaberete Rotate X 90 
Deg, Rotate Y 90 Deg ili Rotate Z 90 Deg. Pritisni-
te taster Tab ili Shift + Tab da biste rotirali kompo-
nentu za 90 stepeni odnosno -90 stepeni u pret-
hodno odabranom smeru. Paletu Rotate context 
toolbar možete odvući bilo gde u oblasti za crta-

Slika 12-3  Pano Begin Assembly 
PropertyManager
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nje. Pored toga, ime izabrane komponente biće prikazano u polju Insert Compo-
nent na potpanou Part/Assembly to Insert a prikaz dela pojaviće se u oblasti Preview 
potpanoa Thumbnail Preview. Preporučljivo je da se koordinatni početak prve kom-
ponente poravna s koordinatnim početkom sklopa. Da biste postavili koordinatni 
početak komponente u koordinatni početak sklopa, pritisnite dugme OK na panou 
Begin Assembly PropertyManager.

Da biste postavili druge komponente u doku-
ment sklopa, aktivirajte alatku Insert Components 
s panoa Assembly CommandManager (slika 12-4); 
otvoriće se pano Insert Component PropertyMana-
ger. Pritisnite dugme Browse, otvoriće se okvir za 
dijalog Open. Izaberite komponentu u okviru za dijalog Open; kursor će biti zame-
njen kursorom za rad s komponentama, a prikaz komponente pojaviće se u obla-
sti za crtanje. Pritisnite levim tasterom miša negde unutar oblasti za crtanje da bi-
ste postavili komponentu.

Ukoliko je komponenta koju ćete umetnuti otvorena u drugom prozoru, ona će 
biti navedena u polju Open documents na panou Begin Assembly PropertyMana-
ger ili na panou Insert Component PropertyManager. Da biste umetnuli kompo-
nentu, izaberite je i pomerite kursor u oblast za crtanje; komponenta će biti zaka-
čena za kursor. Pritisnite levi taster miša da biste postavili komponentu. Ako želite 
da vidite izabranu komponentu, proširite potpano Thumbnail Preview.

Opcija Start command when creating new assembly na potpanou Options pa-
noa Begin Assembly PropertyManager unapred je uključena, a koristi se za automat-
sko otvaranje panoa Begin Assembly PropertyManager kada se otvori nov dokument 
sklopa. I polje Graphics preview s potpanoa Options već je izabrano, a služi za uklju-
čivanje grafičkog prikaza komponente koja je izabrana za umetanje. U konceptual-
noj fazi procesa projektovanja, možda će vam zatrebati da umetnete komponentu 
kako biste nešto isprobali. U takvim slučajevima, potvrdite opciju Make Virtual da 
biste komponentu umetnuli kao virtuelnu. Kad potvrdite ovu opciju, komponenta 
će biti snimljena u datoteku sklopa. Prema tome, ako promenite svojstva dela u ori-
ginalnoj datoteci, promene se neće odraziti na umetnutu virtuelnu komponentu i 
obrnuto. Da biste snimili virtuelnu komponentu u spoljnu datoteku, pritisnite deo 
desnim tasterom miša, iz priručnog menija odaberite opciju Save Part (in External 
File) i zadajte lokaciju. Slično tome, da biste promenili ime virtuelne komponente, 
pritisnite komponentu desnim tasterom miša, iz priručnog menija odaberite opciju 
Rename Part, pa zadajte lokaciju u okviru za dijalog Save as.

U programu SOLIDWORKS, deo možete umetnuti u okruženje sklopa i kao 
ovojnicu (engl. envelope). Komponenta koja je tako umetnuta biće prikazana kao 
providna, tako da se ostale komponente smeštene unutar nje vide spolja. Da biste 
u okruženju sklopa komponentu postavili kao komponentu u ovojnici, potvrdite 
opciju Envelope na potpanou Options; deo koji se umeće u sklop biće providan. 
Pritisnite levim tasterom miša unutar oblasti za crtanje da biste postavili taj deo. 
Stanje ovojnice komponente možete promeniti u svakom trenutku. Da biste to ura-
dili, izaberite deo i alatku Component Properties s prikazane priručne palete alat-
ki; otvoriće se okvir za dijalog Component Properties. Isključite opciju Envelope u 
oblasti Configuration specific properties okvira za dijalog Component Properties; 

Slika 12-4  Paleta Rotate 
context toolbar
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data komponenta će se izmeniti na način ostalih komponenta sklopa. Na potpa-
nou Options, unapred je izabrana opcija Show Rotate context toolbar. Kao rezul-
tat toga, u oblasti za crtanje prikazaće se paleta alatki Rotate context toolbar. Da 
biste sakrili paletu Rotate context toolbar, isključite opciju Show Rotate context to-
olbar na potpanou Options.

Savet
Ako treba da postavite više komponenata ili više instanci iste komponente, 
pritisnite dugme Keep Visible na vrhu panoa Begin Assembly PropertyManager 
i izaberite tačke za postavljanje instanci u oblasti za crtanje.

Početak izrade sklopa od part dokumenta 
  Glavni meni:		  File > Make Assembly from Part				     
  Paleta menija:		  Potpaleta New > Make Assembly from Part/Assembly	

Dokument sklopa možete započeti već u dokumentu part. Ako je u režimu 
rada s delovima otvoren dokument osnovne komponente sklopa, odaberi-

te New > Make Assembly from Part/Assembly s palete menija ili iz glavnog meni-
ja izaberite File > Make Assembly from Part. Ukoliko se otvori okvir za dijalog New 
SOLIDWORKS Document, pritisnite u njemu dugme OK. Otvoriće se dokument 
sklopa i pano Begin Assembly PropertyManager. Na tom panou pritisnite OK da 
biste komponentu postavili u koordinatni početak.

Napomena
Ako ste okvir za dijalog New SOLIDWORKS Document prethodno otvorili u 
režimu Novice, kada sklop budete pravili od dokumenta dela otvoriće se Begin 
Assembly PropertyManager. Ukoliko ste prethodno radili u režimu Advanced 
okvira za dijalog New SOLIDWORKS Document, prvo ćete morati da izaberete 
šablon sklopa, a potom da pritisnete dugme OK. Ukoliko pritisnete dugme Make 
Assembly from Part/Assembly i pojavi se SOLIDWORKSov okvir za dijalog sa 
upozorenjem, pritisnite u njemu Cancel. Otvoriće se napredna verzija okvira za 
dijalog New SOLIDWORKS Document (režim Advanced).

Postavljanje komponenata upotrebom otvorenog prozora 
dokumenta
Druga rasprostranjena metoda postavljanja komponenata u sklop jeste upotre-
ba otvorenih dokumenata delova. Uzmimo za primer sklop koji se sastoji od tri 
komponente. Otvorite dokument dela koji hoćete da umetnete, a potom i nov 
dokument sklopa. Zatvorite Begin Assembly PropertyManager. Iz glavnog menija 
odaberite Window > Tile Horizontally ili Tile Vertically; svi otvoreni prozori doku-
menata biće poređani horizontalno, odnosno vertikalno.

Prvu komponentu sklopa treba da postavite u koordinatni početak. Ukoliko on 
nije prikazan u dokumentu sklopa, s palete View (Heads-Up) odaberite Visibility 
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off > View Origins. Postavite kursor na komponentu u prozoru crteža. Levim taste-
rom miša pritisnite komponentu, ne puštajte levi taster miša i prevucite kursor na 
koordinatni početak sklopa u dokumentu sklopa (slika 12-5). Kada se ispod kur-
sora komponente pojavi znak podudarnosti, pustite levi taster miša. Ako se otvo-
ri priručna paleta Mate, pritisnite dugme Add/Finish Mate da biste komponentu 
postavili u sklop. Na isti način dodajte i ostale komponente sklopu. Ako je otvoren 
dokument drugog sklopa, možete prevući deo i iz tog dokumenta. 

Savet
Možete istovremeno sakriti poreklo, relacije skice, standardne ravni, ose i drugo 
pozivanjem alata Hide All Types sa trake sa alatkama View Heads-Ups.

Slika 12-5  Premeštanje komponente iz postojećeg prozora u datoteku sklopa

Postavljanje komponenata pomoću okna poslova File Explorer
Komponente možete postavljati u dokument sklopa i tako što ćete ih izabrati u 
oknu poslova File Explorer. Otvorite File Explorer i pronađite mesto na kom su 
sačuvani dokumenti delova. Postavite kursor na ikonicu dokumenta dela u File 
Exploreru; na ekranu će se pojaviti prikaz komponente (slika 12-6). Pritisnite i dr-
žite pritisnut levi taster miša, pa prevucite dokument dela u prozor dokumenta 
sklopa. Pustite taster miša u oblasti za crtanje dokumenta sklopa da biste tu posta-
vili komponentu.


